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NAVTEX-receiver on 518 kHz in English and on 490 kHz in national language
Sea weather-receiver of the German weather service at 147,3 kHz
Barograph including storm warnings
Storage of Synop-messages 
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All rights are reserved.
Technical ones are subject to change.

An liability for the correctness of the contents of this publication cannot be 
taken over.
In spite of careful processing and programming a defect and/or complete 
failure of the WIB3 can not be completely excluded. Due to atmospheric 
disturbances or to disturbances of other electrical and electronic devices, 
contents of messages can be falsified. The operators of the transmitting 
plants can change or stop the broadcasting service (temporarily or 
permanent).
Therefore no liability for availability and correctness of the indicated 
messages are taken over. In particular no liability for possible damages 
resulting from use of the WIB3 and information of this manual will be taken 
over.
In this manual trademark, trade-names, customer-names, etc. are used. 
Even if these are not particularly characterized, the appropriate protection 
regulations are effective. 

Note
Software updates for this product are available in the Internet: 
http://www.wetterinfobox.com/english/Downloads.htm
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Scope of supply

The following parts belong to the scope of delivery of the WIB3:
• 1 x WIB3,
• 1 x USB-cable,
• 3 x NiMH rechargeable batteries AA, 2100mAh (are placed inside the 

device),
• CD with WIB3- software,
• Installation-Manual.
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Introduction

The WIB3 is a special receiver for NAVTEX and weather messages for your 
board PC. The device receives international NAVTEX messages on 518 kHz 
in English language and national NAVTEX- messages for sports navigation in 
the respective national languages on 490 kHz.
The German weather service will likewise be received on frequency 147.3 
kHz in German language for sea-weather- forecasts, weather-prognoses, 
forecasts and station messages. 
All three frequencies are received and automatically stored at the same time. 
Thus adjusting a time-steered frequency shift is not necessary; this simplifies 
the application of the device.
Synop-messages can be used for representation of wind-arrows and wind-
direction.  In addition to the usual sea-weather forecasts the DWD also sends 
encoded weather information, the so-called Synop / ship messages. The 
WIB3-software is able to decode the Synop-messages and  display them on a 
chart as wind-arrows.
The WIB3 equiped with an inserted precision air pressure sensor, is able to 
record the air pressure during a period of up to seven days. 
The device will be connected to the PC via an USB-interface. It is similar to 
an USB-memory-stick and appears as a new storage-medium on the PC. 
This storage-medium contains all received messages as well as all data of 
the air-pressure sensor.
The WIB3 contains rechargeable batteries, which makes it independent of 
external power supply. The rechargeable batteries can be used for a period of 
operation of approx. seven days. 
The device does not have any control elements. All functions will be activated 
by the PC.   
When the batteries has been charged, the WIB3 will automatically receive 
and store all necessary information, which can be called up via PC. The WIB3 
will switch off, when the batteries are low and need a recharging. 

The software

The operation of the WIB3 will be done by a comfortable Windows-software. 
The software is working with the operating systems Windows ME, 2000 and 
XP, available in German or English version.
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Software-updates for the WIB3 will be spread via the internet. Nevertheless, 
please look for time to time under http://www.wetterinfobox.com, to make 
sure, you have the latest version. 

Software installation

The software of the WIB3 is stored on the enclosed CD, which is part of the 
scope of delivery. In the file Deutsch on the CD you will find the installation 
program for the German version. The file English contains the appropriate 
installation program for the English version. 
In order to install the software please start the required installation program 
(Setup.exe) with a  double-click. Afterwards you have to follow the 
instructions shown on the screen. 
After installation the WIB3 is ready for operation. Please attach the WIB3 via 
USB-cable to the PC and start the WIB3-program on the PC screen via the 
icon.

Weather-messages

In order to view weather-messages please 
activate the tab WEATHER. Afterwards you 
can click on a message type in the weather 
menu structure. The appropriate message 
appears in the message window on the right 
side. The last two messages of each message 
type are indicated.

New messages are displayed in the menu tree in bold font. Messages which 
were already displayed once are shown in normal font.
Please pay attention: WIB3 will be delivered including weather messages for 
demonstration purposes. Actual messages will be displayed not until 
receiving the newest one.
The transmission method (RTTY), which the German weather service uses 
for transmission of the messages, permits no error recognition. Therefore 
errors can be contained in the indicated weather broadcasts, which are not to 
be recognized as such. The receipt-range of the WIB3 amounts to approx. 
300 nautical miles with optimal receipt possibilities starting from Hamburg 
Pinneberg.
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NAVTEX- messages

In order to view NAVTEX- messages, please 
activate the tab NAVTEX. Here the NAVTEX 
menu structure is shown, in which the NAVTEX 
messages are sorted according to their 
message type. For the two NAVTEX 
frequencies 490 kHz and 518 kHz two menu 
structures are available, one for each. The 

entire menu structure can completely be opened with the button   and 
closed with the button  .
New messages are displayed in the menu tree in bold font. Messages which 
were already displayed once are shown in normal font.
All NAVTEX- messages will automatically be stored for two days and 
afterwards deleted. The transmission method for NAVTEX- messages (Sitor) 
permits a reduced recognition and correction of transfer errors. Characters, 
which were not received correctly, will be represented as underscore (_).  It 
can occur nevertheless that also normally represented characters are 
incorrect. 
The structure of a NAVTEX message is to be explained on the basis  of 
following example:
ZCZC PA09
NETHERLANDS COASTGUARD
NAVIGATIONAL WARNING NR. 9 172128 UTC AUG
PLATFORM L10-G 53-29.4N 004-11.7E
UNLIT
NNNN
Each NAVTEX- message begins with the letters ZCZC, followed by the 
message identification (PA09). The first letter of the message identification 
serves the master station for the identification. In this case it is 
NETHERLANDS COASTGUARD (P).
In the second letter the kind of message is coded, here navigational warning 
(navigation warnings). The last two numbers of the message identification 
(09) are a serial-number. The number 00 has a privileged position. It is 
reserved for distress messages. 
NAVTEX messages have a time stamp. It is shown at the end of the third line 
(172128 UTC August) and means: 17. August, 21:28 UTC. The time stamp 
refers to the date, the message was produced and not to the time of the 
radiant transmission. Afterwards  the message content follows. The message 
ends with NNNN.  
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The following table contains an overview of the different message-types:

Code Message-type Menu option
A Navigational warnings Navigational warnings
B Meteorological warnings Meteorological warnings
C Ice reports Ice reports

D Search and rescue information Search and rescue 
information

E Meteorological forecasts Meteorological forecasts
F Pilot service messages Pilot service messages

G Information about DECCA navigation- 
system Electronic navaid messages

H Information about LORAN navigation- 
system Electronic navaid messages

J Information about GPS navigation-system Electronic navaid messages
K Information about other navigation-systems Other messages

L Additional navigational warnings (f. e.  ring-
moves) Additional warnings

V Additional navigational warnings (f. e.  ring 
list) Remaining messages

W Reserved for special service Remaining messages
X Reserved for special service Remaining messages
Y Reserved for special service Remaining messages
Z QRU (no messages) Remaining messages

Barograph

The third tab contains the BAROGRAPH. The 
measuring data are represented in the 
diagram from left to right. I.e. the current 
measured value is on the right side of the 
curve. The barograph has a measuring interval 
of one minute and resolution of 0,1hPa. 
The representation period can be decreased 
with the Zoom-In-Button  and increased with 

the Zoom-Out-Button  . The temporal gradation is 6h, 12h, 24h, 48h and 7 
days. 
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You can increase a cut-out of the air pressure curve. 
Draw in addition a rectangular window with the 
mouse from above left downward right. Use the left 
mouse button. If the mouse button is released, the 
appropriate range of the diagram will be shown 
increased. 
The enlargement can be cancelled again by drawing 
any rectangular window with the mouse in reverse 

direction (from downside right upward left). 
The diagram is movable in any direction. Click in addition with the right 
mouse button into the air pressure curve and move the mouse. As long as 
you keep the mouse button pressed, the air pressure curve will follow the 
mouse movements.
The data of the barograph are only up to date, if a WIB3 is attached to the 
computer. Then the curve is represented in blue colour. If the air pressure 
data are not up to date (no WIB3 attached), the curve will be represented in 
black. 
The WIB3 indicates the absolute air pressure. The shown value will not be 
converted to sea level. The air pressure will decrease by 1hPa per 8m. E.g. in 
a height of 80m above sea level the indicate pressure of WIB3 is 10hPa lower 
than the pressure at sea level.

While the WIB3 is attached to the PC, the current temperature, the air 
pressure and the three hours of air pressure tendency are indicated on top of 
the screen. 
Please note, that the data of the barograph are lost, if the batteries of the 
WIB3 are exhausted. Therefore you should charge the batteries in time.
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Gale-warning

With fast changes of air pressure the gale danger is 
particularly high. In order to relieve you from the 
constant observation of the air pressure process, 
you can switch on the storm-warning. This function 
will be opened by the menu Settings->Gale warning.
Depending on the setting, an alarm will be released, 
if the air-pressure falls within one hour more than 2 
to 5 hPa.
In the case of an emergency the WIB3 sends an 

acoustic audio signal and all three light emitting diodes at the device are 
flashing rhythmically. If the WIB3 is attached to the PC, there will also be a 
gale-warning indicated in the WIB3-program. In addition a warning-window 
will be opened. The alarm will be switched off by closing the window. Without 
user interference the audio signal will be switched off after one minute. The 
light emitting diodes will continue to flash. You can test the gale-warning 
function by starting the simulation.

Synop data

In addition to the well-known weather messages the DWD sends encoded 
meteorological data of firm weather stations and ships. 
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The WIB3-Software decodes these data and indicates it in a map as wind 
arrows.
Please activate the tab SYNOP for the representation of the Synop data. A 
pixel map of parts of the North and Baltic Sea will be shown. The red arrows 
in the map will show Synop messages at the appropriate position. The white 
arrows will show a weather station from the DWD Station reports for the North 
and Baltic Sea.
Resting with the mouse pointer above an arrow, a reference display window 
appears and shows the radio call sign of the Synop message (or the station 
name with DWD station messages), the wind direction, the wind force as well 
as day and time of the message (UTC).

To display all decoded information of a 
Synop Message please click on the 
appropriate wind arrow (see page 9). 
A window will be opened with the data 
in plain text. If you click on a white 
arrow, the station messages of  North / 
Baltic Sea are indicated. The station 
belonging to the arrow is marked by a 
star (*) in the beginning of the line.
You can close the Synop Window with 
a click at the Close-button or with a 
double-click into the text. The Synop 
data are also available in coded form 
on the WEATHER-tab (in the menu 
tree below Synop). It is possible to 

store the data into a file, for e.g. to decode it with another program.

Important note:
Transmission errors in the encoded Synop data cannot be recognized, since 
no check sum is present. In addition already small errors in the encoded data 
causes absolute wrong results during decoding. So please pay attention of 
the data from the Synop messages and refer also to other sources of 
information for weather determination.

Status-line

The status line is located at the lower edge of the WIB3-program-window.
At this line information of the condition of the WIB3 are indicated. 
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The following information are contained in the status line
(from the left to the right): 

● Information of the data communication with progress bar, 
● Information of new NAVTEX messages, 
● status of battery, 
● status of the WIB3.

Function overview

The following table gives an overview about the functions of the WIB3:

Menu option Icon Function

File->Open... Opens an already stored message. 

File->Save... Stores a message. 

File->Print... Prints a message or a barograph-
curve. 

File->Exit Terminates the program. 

Settings->Gale warning... Opens the dialogue for adjustment of the 
gale-warning. 

Settings->Expand tree Opens / unfolds the NAVTEX-menu 
tree. 

Settings->Collapse tree Closes / folds the NAVTEX- menu 
tree. 

Settings->Zoom In Increases the barograph view (only the 
time scale). 

Settings->Zoom Out Decreases the barograph view (only 
the time scale). 

Help->Manual... Opens the User Manual. 

Help->System information... Shows system information of the 
software and of the WIB3. 

Operating instructions

Environment

Please use the equipment only in the interior in dry environment. Do not 
expose the equipment in use to temperatures higher than 50°C and lower 
than 0°C. 
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Switching the WIB3 on & off

The WIB3 has no operating controls. The device is switched on when it is 
attached to a PC. It switches off automatically, if the internal battery is empty. 
Thus it is guaranteed that the battery does not become deep-discharged. 

Hints to radio reception

The internal ferrite rod antenna of the 
WIB3 has a directionality. For good 
reception the equipment must be 
operating flat lying. With small 
distance to the transmitter the 
directionality of the antenna will 
become hardly noticeable. The range 
of the bad receipt (see illustration) is 
hardly to be determined.
With increasing distance from the 
transmitter the directionality of the 
antenna will become more visible. In 
this case the WIB3 must be aligned 
to the transmitter for a good receipt. 
A good weather receipt can be 
examined by the WEATHER LED. In 
case of good receipt the LED flashes 
evenly fast.
In case of bad or no receipt the  LED 
flashes irregularly or not at all.

Electromagnetic interferences can impair the receipt. This can occur due to 
e.g. computer, electronic navigation equipment, fluorescent lamps, inverters, 
battery chargers, generators, electric motors, high voltage transmission lines 
etc. Therefore the equipment should be positioned as far away as possible 
from this equipment. The light emitting diode WEATHER on the WIB3 must 
flash evenly fast, for a perfect weather receipt.
The receipt can be impaired also by atmospheric disturbances (e.g. 
Thunderstorms). The receipt range for weather broadcasts is approx. 300 
nautical miles around Hamburg Pinneberg at optimal receipt possibilities. 
Steal and/or aluminium yachts are like Faraday's cages. Therefore is to be 
counted that there is only an insufficient receipt.
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Rechargeable batteries

The WIB3 contains three NiMH rechargeable batteries, type AA with a 
capacity of 2100 mAh. The batteries are charged via the USB-interface of the 
PC. Fully charged batteries last in use for approx. seven days. 
The battery-management of the WIB3 always provides for optimally charged 
batteries, so you don't have to pay attention about the recharging of the 
batteries. If you do not want to use the WIB3 for a longer period (longer than 
one year), it is meaningful to take out the batteries in full-charged condition 
out of the device and to replace them when needed. Pay particular attention 
to the correct polarity. 
If you want to exchange the batteries, use only fast-chargeable NiMH 
batteries, type AA with a capacity of min. 2100 mAh. Used up batteries must 
duly be disposed and do not belong into domestic-waste.

Operational status indicators

The WIB3 has three light emitting diodes (LEDs), which have the following 
meaning:

LED Lights Meaning

POWER

Steady light Operation via PC, the batteries are 
completely charged.  

Flashes evenly Operation via PC, batteries are 
charged 

Short flash Battery-operation 
Off Device is swiched off 

WEATHER
Flashes evenly fast Good reception (DWD, 147,3 kHz) 
Off or irregular flashing Poor or no reception (DWD) 

NAVTEX
Regular shining Just receiving a NAVTEX-message 

Off Waiting for a NAVTEX-message
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Specifications

Receipt-frequencies 518 kHz, 490 kHz and 147,3 kHz 

PC-interface USB full speed, socket mini-B
5-pin 

Rechargeable battery 3 x NiMH batteries, type AA, 
2100mAh 

Power input in batterie-operation Approx. 12 mA 
Resolution of the temperature 
indication 0,1°C 

Measurement error of the 
temperature sensor ±1°C 

Resolution of the air-pressure sensor 0,1hPa 
Absolute measurement error of the 
air-pressure sensor ±1,5hPa

Typical long-term stability of the air 
pressure sensor -1hPa/year 

Air-pressure measuring interval 60s
Maximum recording span air-
pressure 7 days 

Battery-operation period Approx. 7 days 

Power input USB 450 mA max. when charging, 
otherwise 17mA 

Battery-charge-time 5-6 hours
Operating temperature 0...50°C 
Supported operating systems Windows ME, 2000, XP 
Memory for messages 1MB flash-memory 
Antenna Internal ferrit core antenna 
Dimensions (LxWxH) Approx. 121mm x 56mm x 31mm 
Weight 186g with batteries, without cable 

For inside use only.
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Accesories

12 / 24 Volt charge adapter for WIB3 
Continuous operations on board are possible, 
independently of the PC.
Cigarette lighter plug with USB socket for charging of the internal 
batteries via 12 V electrical system. Usable with the USB-cable 
contained in the scope of supply. 

Item-No.: 38153

230 Volt charge adapter for WIB3 Item-No.: 38154
Nylon bag for WIB3 Item-No.: 38160
NAVTEX translation-support English-German Item-No.: NÜ

Warranty

If the WIB3 exhibits a defect due to production or material defects within 24 
months starting from the purchase date, it is either repaired by us or 
exchanged free of charge against appropriate equipment. 
To wearing parts (e.g. housing, batteries, etc.) the warranty applies for six 
months starting from purchase date. 
The warranty does not apply, if the defect is caused on inappropriate 
treatment or neglection of the manuals. 
A receipt of the warranty voucher with purchase date is required.
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Devices with a crossed out dustbin label have to disposed in the European Union via a separate garbage 
collection at a suitable collective places for the recycling of electric and electronic devices.

MÖRER SCHIFFSELEKTRONIK does not take responsibility for injuries or damages, which 
develop during or in consequence of the installation of this product. Each article of equipment can 
fail by various different reasons. Never use this equipment as the only information source, if by the 
loss of the equipment a danger exists for lives, health or material possession. Remember: This 
equipment is only assistance for the weather- and message information, and is no replacement for 
good sailor shank. The use of the equipment is on your own risk. Use it carefully and test its 
operability occasionally on the basis of other data from time to time.
No part  of  this  publication  may be  reproduced,  copied,  stored in  a  retrieval  system or 
transmitted in any form, electronic or otherwise without prior written permission from Mörer 
Schiffselektronik.
Mörer Schiffselektronik hereby grants the right to load an individual copy of this manual on non 
removable disk or another electronic storage medium for looking at it on a computer and to print 
out  a copy of  this manual,  if  this  electronic or  printed copy contains the complete text  of  this 
copyright explanation and a further unauthorized commercial spreading of this manual strictly one 
forbids. All rights reserved. 
The information  contained herein  can be changed at  any time  without  previous  proclamation. 
Mörer  Schiffselektronik  reserves  itself  the  right  to  change  or  improve  the  products  without 
notification.

16


	Scope of supply
	Introduction
	The software
	Software installation
	Weather-messages
	NAVTEX- messages
	Barograph
	Gale-warning
	Synop data
	Status-line
	Function overview

	Operating instructions
	Environment
	Switching the WIB3 on & off
	Hints to radio reception
	Rechargeable batteries
	Operational status indicators

	Specifications
	Accesories
	Warranty

